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Lesson 1 

Essentials of the TradeStation Desktop 

Learning TradeStation 

 
 

Installation and System Requirements 
 
Before installing TradeStation, it is important to consider your computer’s performance specifications.  
The quantity and quality of your computer’s system resources will directly affect the TradeStation 
platform’s overall performance.  Following are the minimum and recommended resource levels 
depending on which type of TradeStation user you will be.     
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Understanding User Profiles 
 

Minimum  
Requirements User  
 
The common profile of the 
minimum requirements user is a 
TradeStation platform user who 
is not sensitive to real-time 
market data updates and who 
makes decisions based on 
market analysis that is not time 
sensitive.  Traders who fit this 
profile are usually position 
traders or end-of-day traders. 

Standard User  
 
A standard user is generally 
anyone who is moderately 
sensitive to real-time market 
data updates and makes 
intraday decisions based on 
intraday market analysis.  
Traders who fit this profile are 
swing or trend traders. This 
type of user generally doesn’t 
need more than a handful of 
market data requests and 
follows specific symbols that 
are not extremely active.  The 
standard user doesn’t rely on 
processor-intensive analysis 
techniques running in real time 
on multiple charts. 

Power User  
 
A power user is generally a 
user utilizing computationally 
intensive EasyLanguage 
studies, utilizing large amounts 
of tick or intraday data, or 
generating a large amount of 
trading activity.  Traders who fit 
this profile are active 
TradeStation traders or users 
who require the ability to follow 
multiple active markets 
simultaneously while using 
complex EasyLanguage studies 
and strategy optimizations. 

 

 
There are three icons that are displayed as part of the TradeStation installation.  Click on the Start – All 
Programs – TradeStation menu sequence from the Windows Task Bar to access all icons. 
 

 
 

 
 
This icon launches 
TradeStation, a comprehensive 
trading platform that enables 
you to execute trades, monitor 
your positions, analyze markets 
and use built-in and custom 
analysis and strategy trading 
tools. 
 
 

 
 
This icon launches the 
TradeStation Development 
Environment, which provides 
you with an integrated set of 
tools to write, edit and verify 
EasyLanguage analysis 
techniques, strategies and 
functions.   
 

 

 
 
This icon launches a 
customizable ticker bar across 
the bottom of your screen, 
which allows you to track the 
market  through the use of hot 
lists, real-time quotes and news 
headlines.  
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Live Trading vs. 
Simulated Trading 
 
The TradeStation Network Logon 
dialog appears when you click the 
TradeStation icon.  It allows you to 
choose whether to trade in your 
actual brokerage accounts or using 
a trading simulator.  The Live 
Trading button will log you in to your 
real funded brokerage accounts; 
trades will be real and profit and 
losses will affect your funds.  To 
practice trading with simulated 
accounts, click on the Simulated 
Trading button; any orders placed 
will not be real, nor will any profits 
or losses be real. 
 
Keep in mind that pressing the 
Enter key on the keyboard after 
entering the password will default to 
Live Trading.  
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When logging on to simulated trading, the confirmation window below is displayed. 
 

 
 
The Status Bar displays “Trading: Sim” in blue to confirm that you are using simulated trading.  Your 
account numbers should start with the letters “SIM” to confirm that you are using simulated accounts. 
 

 
 
To switch from simulated trading to live trading or vice versa, double-click on the “Trading” or “Data” 
indicators on the Status Bar to log off the TradeStation Network.  Double-click again to return to the 
Network Logon dialog.  When logged on to live trading, the Status Bar shows “Trading: Live” in green. 
 

 
 
You may also disconnect TradeStation from the data and trading networks by clicking on the File – Work 
Online menu sequence.  To reconnect, click on the File – Work Online menu sequence again.   

 
The Work Offline button on the TradeStation Network Logon dialog allows you to use 
TradeStation offline.  This is convenient when an Internet connection is not available.  
TradeStation automatically saves historical data for all the Chart Analysis windows 

you loaded while connected to the Internet.  This way, the data is available for offline viewing and 
analysis.  You will not receive any new data until you log back in to the TradeStation Network. 

 
Click the Network Status button to see information about the TradeStation data and 
order execution networks.   
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Desktop Components 
 
 

 
 

 
Menu Bar ● This provides drop-down menus to access general program features as well as features 
related to the currently selected window. 
 
Toolbar ● This contains buttons for accessing tools specific to the currently selected window. 
 
Order Bar ● This is used for manually placing orders in your TradeStation brokerage accounts. 
 
Position Graph Bar ● This displays the status of positions in your TradeStation brokerage accounts. 
 
TradingApps Launcher ● This tool allows you to launch new windows or TradingApps in the platform 
with a single mouse click.  Its rollout functionality saves space on your desktop. 
 
Status Bar ● This bar is located at the bottom of the TradeStation screen display and provides a current 
summary of your brokerage account as well as network connection status.  It is also used to lock and 
unlock manual order-entry tools.  
 
Workspace Area ● This is the open area inside the TradeStation desktop that is used to create and 
display windows such as Chart Analysis, Quotes, etc.  
 
 
 
  

Menu Bar 

Tool Bar 

Order Bar 

Position 

Graph Bar 
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Launcher 
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Desktop elements may be removed or enabled by using the View menu. In the View drop-down menu, 
the top five elements will be checked or unchecked.  Click the unchecked elements to enable them.   

 
You can position the TradingApps Launcher anywhere along the edge of the desktop.  
The Order Bar and the Position Graph Bar can be removed by clicking the “x” in one of 
their corners.   You may also click and hold the handle that appears as a dotted line 

next to the “x” to drag the bar and move it to a different location.  Double-clicking the handle will make it 
float.  Double-clicking the title bar of a floating bar will dock it to its previous location in the desktop.  
 

Workspaces and Windows 
 
Workspaces are groups of TradeStation windows that you want to view, save and re-open as a group.  In 
fact, each workspace is a file containing the windows you have placed in it. 
 
Create your workspaces so that they help you organize your trading ideas.  You can create workspaces 
with any variety of windows for a single stock, a group of stocks, an industry, futures, forex or any other 
information that you want to view together. TradeStation includes sample workspaces so you can get an 
idea of how they look. 
 
When you first create a workspace, it is blank.  You then add windows to the workspace (Chart Analysis, 
RadarScreen, Matrix, and so on).  When you want to analyze other stocks, industries or markets, and 
want to keep your ideas separate, you can create additional workspaces. 
 

 
 
 
Note: For an Alert to be triggered or Strategy Automation to be active, the workspace containing the 
window with the Alert or Strategy must be open. 
 
 

Workspace tabs 
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TradeStation displays a tab for each open workspace.  You may click on these tabs to switch between 
them.  To create a New Workspace, click on the File – New – Workspace menu sequence.  Other useful 
functions from the File menu are: Open Workspace, Save Workspace, Save Workspace As…, Save 

All Workspaces and Move Workspace. 
 
Right-click on any of the workspace tabs 
and use the shortcut menu to create, save, 
close and move workspaces.   You may 
also click and drag workspace tabs to 
change their order. 
 

Copying and Pasting Windows 

 
You may copy and paste windows within a workspace or from one workspace to another.  The Copy 
Window command makes an exact duplicate of any TradeStation window, including symbol settings, 
applied Analysis Techniques or columns and any window formatting settings.  The Paste Window 
command will place that window into the active workspace.  The copy is fully functional and may be 
edited or saved in the same ways as any other window.  These commands are available from both the 
Edit menu and right mouse-button shortcut menu for each window. 
 
Note: Strategy Automation is automatically disabled in a Chart Analysis window that is being pasted. 
 

Managing Windows in a Workspace 

 
Resize Windows 
All windows in TradeStation are created using a default size.  You may click and drag any of the side 
borders of a window to resize it; clicking and dragging the corners of the window will resize the width and 
height of the window simultaneously.  
 
Move Windows 
Click and drag the title bar of a window to move it to another location within the workspace.   
 
Maximize and Minimize Windows 
To maximize a window, click the Maximize button on the top right corner of the window.  Maximized 
windows cover the whole workspace area and other open windows are behind it.  To restore the window 
to its original size, click on the second (lower) Restore Down button at the top right corner of the 
TradeStation desktop.   
 
Minimized windows appear as icons at the bottom of the workspace, right above the Workspace tabs.  
Click on Window from the Menu Bar to see a list of windows in the workspace; click on any of them to 
restore it and make it the active window.      
 
Arrange Windows 
Click on the Window – Arrange All menu sequence to evenly resize all open windows and arrange them 
to fill the whole workspace area.  Other options in this menu are: Arrange Horizontally, Arrange 
Vertically and Cascade.   
 
 

 
 
 

Right-click menu 
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Multiple Desktops and Multiple Monitors 
 
TradeStation allows you to create multiple instances of the TradeStation desktop. Each desktop is a 
complete version of TradeStation with access to all of its features. Each TradeStation desktop may then 
be placed on any of the monitors connected to your computer. 
 
When you first install TradeStation, the installation process will recognize all monitors connected to your 
computer and will prompt you to select how many monitors to use for TradeStation. Once installation is 
complete, TradeStation should open a new desktop on each of the monitors selected.   
 
To create an additional TradeStation desktop, click on the File – New Desktop menu sequence.  The 
new desktop should automatically open on any available monitor.  If it opens on the incorrect monitor, 

click on the “Restore Down”    button located between the “Minimize”   and “Close”    buttons on 
the top right corner of the desktop, and then click the desktop’s title bar and drag it to the desired monitor.  
 
You may open as many additional desktops as needed. 

 

 
 
Desktops may also be saved, each with its associated workspaces, so that you can retrieve the desktops 
when needed. Use these menu sequences: 
  
File - Save Desktop 
File - Save Desktop As… or 
File - Save All Desktops. 
 
To open a saved desktop, click on the File – Open Desktop menu sequence.  All workspaces associated 
with this desktop will open.  To close a desktop, click on File – Close Desktop menu sequence or click 
on the “Close”    button at the top right corner of the desktop.   
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Backup and Restore 
 
The TradeStation backup feature makes it easy to save – in a single archived file – all of the changes you 
make while working with workspaces, templates and dialogs.  This allows you to save custom 
configurations and to efficiently transfer your custom settings between computers or to a newer installed 
version.   
 
Backup archive files may be created as needed or they may be generated automatically on a regular 
schedule.  To create a backup, use the File – Backup/Restore TradeStation menu sequence and 
choose the Backup TradeStation… sub-menu.  From the TradeStation Backup dialog, place a check 
mark next to those components that you want to include in a specific archive.   
 
The archive file name is made up of the backup configuration name selected from the drop-down at the 
top of the dialog, the TradeStation version number, and the date and time.  For example, an archive file 
named “Monthly (9.00.00.8732 – 2011-07-06 0910)” means that it was created using the Monthly backup 
configuration, using TradeStation version 9.0, and created on July 6, 2011 at 9:10 am.  The archive file is 
stored by default in the C:\Program Files\TradeStation Archives directory.  You may choose a different 
location by clicking on the Browse… button.     
 
To restore saved data, choose the Restore TradeStation Archive… option from the File – 
Backup/Restore TradeStation menu sequence.  Browse to find the name of the archive file you would 
like to restore.  A checkmark next to each component indicates that it will be restored. 

 

 
 
Note: TradeStation stops updating during a backup or restore cycle and automatically reconnects when 
completed.  Therefore, it is recommended that you not perform backups and restores during your regular 
trading hours. 
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Customize Toolbars 
 
Toolbars display buttons that provide quick shortcuts to certain commands.  There are two types of 
toolbars in TradeStation: Shared Toolbars and Window-Specific Toolbars. A Shared Toolbar is available 
across all TradeStation windows. Window-Specific Toolbars are only available for a certain type of 
window, such as Chart Analysis, and contain buttons that are only applicable to that specific window type.  
You will notice that as you create different window types, a different toolbar with an applicable set of tools 
is displayed at the top of TradeStation.   
 
You can also create your own custom toolbars with your most frequently used toolbar buttons.  These 
custom toolbars can be either shared or window-specific.   
 
To create a custom toolbar click on the View – Toolbars – Customize menu sequence.  In the Toolbars 
tab, click on the New button and give your custom toolbar a name.  In the New Toolbar dialog, you may 

specify whether this toolbar will be shared by 
multiple windows or not by checking the Shared 
toolbar checkbox.  Keep in mind that if it is not 
shared, the toolbar will only appear when the 
same window type is active, and will disappear 
when different types of windows are.   
 
Once you click OK, an empty floating toolbar will 
be displayed, ready to accept toolbar buttons.  

 
 
 

 
To add buttons, click on the Commands tab in the 
Customize dialog, and commands are displayed 
on the right based on the category selected on 
the left.  
 
Keep in mind that only commands for the window 
that is active on the desktop will be displayed in 
this dialog.  If you are looking for a window-
specific command, it will not be available unless 
you open that window type and then customize 
the toolbar.   
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To add buttons to the toolbar, simply click on a command button and drag it inside the new toolbar. 
Continue to do this until all the command buttons that you need are added to the toolbar.  You may then 
click the title bar of the new toolbar and drag it to the desired position.  You may use it floating, you may 
drag it until it docks to the top with the other toolbars or you may choose to dock it to a different location 
such as the right, the left or even the bottom edge of the platform.      
 
To remove buttons from existing toolbars, click on 
the View – Customize – Toolbars menu 
sequence, select the Commands tab and then click 
and drag the buttons from the toolbar to the 
Commands tab.   

 

Command Line Macros with Hot Keys and Toolbar Buttons 
 
TradeStation's Command Line is the central command post from which you can control the TradeStation 

desktop, workspaces and windows. The Command Line makes it easy to 
execute common commands in windows by simply typing them. 
Commands are short instructions with optional parameters.  
 
The Command Line accepts the following types of commands: 

 

 Symbol - Symbol commands insert or change the symbol in the active window.  
 

 Interval & Range – Interval & Range commands are used to change the bar interval and/or 
amount of data in the active window.  
 

 Action - Action commands access many of the same operations that can be accessed from 
menus or toolbars in the TradeStation desktop or the active TradeStation window. Action 
commands are preceded with a period (.).  
 

 Macro - Macro commands are action and/or symbol commands combined into a single string. 
Macro commands are preceded with a period (.).  

 
To access a list of commands you may 
use in the Command Line, click on the 
right-pointing triangle next to the Symbol 
Lookup button and select Other 
Commands… from the drop-down menu.  
To access Macros, click on the View – 
Macros… menu sequence.  Here you will 
find built-in Macros under two main 
categories: Command Line Macros and 
Order-Entry Macros.  You may run any of 
the built-in Macros by selecting it and 
clicking the Run button.  You may also 
run them by typing their names preceded 
by a period (.) directly into the Command 
Line.  To create a new Command Line 
Macro, click the Create button.    
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The Create Macro wizard will 
prompt you for the required 
information, including the 
command or series of commands 
to be included in the macro.  
Keep in mind that multiple 
commands are separated by 
double semicolons.  Once the 
macro is created, you may run it 
by typing the macro name 
preceded with a dot directly in the 
Command Line.  
 
You may also run Macros by 
assigning them to a user-defined 
hot key or a toolbar button.  

 
 
 
 
 
To assign a Macro to a hot key, click on the Hot Keys… button in the Macros dialog.   

 
In the Hot Keys dialog, select Command 
Line Macros under Categories.  Most of 
the built-in Macros have assigned hot keys.  
Select any of the Macros under 
Commands and a hot key is displayed 
under Current Keys if it is already 
assigned.   
 
To assign a hot key or change the existing 
one, click inside the “Press new Hot Key” 
field and press the hot keys directly on the 
keyboard.  The keys pressed will appear 
inside the field. Click the Assign button at 
the bottom of the dialog to save the 
changes.   
 
Once the hot key is assigned, you may 
press it at any time to run the Macro.   
 
Click on Save As… at the bottom of the 
dialog to save the hot keys layout and 
allow different user configurations.  The 
default hot keys are saved under the 
TradeStation layout and can be reset by 
clicking the Load button.    
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To assign a Macro to a toolbar button, click the Toolbars… button in the Macros dialog.   

 
In the Customize dialog, select Command 
Line Macros under Categories.  Select one 
of the Macros under Commands and click 
the Modify Button… button if you wish to 
change the appearance of the toolbar button.  
 
Once you have selected the appearance of 
the toolbar button, you may click and drag 
the button directly into a toolbar. Every time 
the toolbar button is pressed, the Macro is 
run.    
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Window Linking 
 
Window linking allows you to connect the symbol and/or interval settings in multiple windows.  To turn on 
window linking, click on the “S” (symbol) button or the “I” (interval) button on the title bar of a window.  The 
buttons turn a specific color when turned on, but you may click the drop-down on these buttons to select 
different colors and create different link groups.   
 
The four windows in the workspace pictured below are linked by a Green Local Symbol Link.  Changing 
the symbol in any of the windows forces all other windows to update to that symbol automatically.    

 

 
 

Symbol Link   

 
Windows linked with symbol links share symbol information. When the symbol is modified in one of the 
windows belonging to the group, the other windows in the group will update to use the same symbol. 
These links can also be set globally to work across multiple workspaces and desktops.  To set a global 
link, select “Color” Global Symbol Link from the drop-down menu of the symbol linking buttons.    

 

Interval Link   

 
Windows linked with interval links share interval information. When the interval is modified in one of the 
windows belonging to the group, the other windows in the group will update to use the same interval. 
These links can also be set globally to work across multiple workspaces and desktops.  To set a global 
link, select “Color” Global Interval Link from the drop-down menu of the interval linking buttons.    

 
 

Symbol Links 
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Listener Link 

 
Listener Links allow a window to be linked so that any change is reflected in the Listener Linked window; 
however, a change made in the Listener Link window is not sent to any other window.  Listener Links may 
be set for Symbol or Interval; the settings appear on the Symbol Link and Interval Link drop-down menus. 
These links may be local (within the workspace only) or global (across workspaces and desktops). 

 

 
 
 
Note: RadarScreen windows are always “sender only” regardless of the type of link you select.  For 
example, changing a symbol in a Chart Analysis window linked to a RadarScreen window will not change 
a symbol in the RadarScreen window.  Clicking on a symbol in the RadarScreen window will, of course, 
change the symbol in the linked Chart Analysis window. 
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TradeStation Desktop Preferences 
 
Desktop preferences are global; they apply to all workspaces in the TradeStation desktop. These settings 
allow you to customize the behavior of your TradeStation desktop and tailor your workspace options. 

General 
Use this tab to determine general preferences, such as resizing window options, confirmations when 
deleting windows, the appearance of window linking buttons, etc.  To enable a setting, click the checkbox 
to add a checkmark. To disable the option, click the box again to clear the checkmark. 
 
View 
On this tab, you can set preferences related to title bars on windows and how they are displayed in the 
TradeStation desktop. 
 
Workspaces 
Use this tab to set the attributes for your workspaces, such as opening all workspaces from previous 
sessions when you start up TradeStation and controlling the list of workspaces that appear in the opened 
and recent workspaces menus.   
 
Desktop Bars 
Here you can change preferences for the EasyLanguage Print Log, Order Entry and the Ticker Bar. 
 
Command Line 
On this tab, you can set preferences related to the Command Line, such as how many items to display in 
the drop-down lists and where to display error messages. 
 
Sessions 
On this tab, you can set the default session that you want to use for each symbol category. You can 
choose the regular session or create a custom session.  
 
Desktops 
Use this tab to set how desktops appear when starting TradeStation and how they close upon exiting. 
 
Updates 
On this tab, you can set the method by which TradeStation platform updates are downloaded to your 
computer, and control the location settings for the Desktops and Workspaces backup.  
 
Status Bar 
On this tab, you can access the preference window to set alerts and general and notification settings, as 
well as messaging settings for the Status Bar. 
 
Dialogs 
On this tab, you can set preferences to determine where pop-up windows will appear when using a multi-
monitor display configuration. 
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TradeStation Help 
 
The TradeStation Platform Help is accessible from the 
Help menu. The Help topics in TradeStation are 
displayed in a separate Help window so that you can 
view them at the same time you are using TradeStation. 
Most windows, dialogs, drawing and analysis tools, and 
right-click shortcut menus contain a Help link or button 
that automatically launches the Help window and takes 
you directly to a related Help topic. In addition, you can 
use the F1 key to open the Help window from anywhere 
in TradeStation. 

TradeStation Help provides you with multiple ways to locate information about how to use TradeStation.   
 
Table of Contents: This tab groups Help topics by category. Click the + to the left of the books to expand 
a category.  Click the – to collapse a category.  Click on a topic name to view the related topic. 
 
Index: The Index tab includes an alphabetical list of terms that are linked to relevant Help topics.  As you 
begin typing characters in the text box at the top of the index pane, the list moves to the index terms that 
start with those characters.  Select a term from the list to view the related Help topic. 
 
Search: The Search tab lets you locate Help topics that contain term(s) you type into the text box at the 
top of the search pane.  A search engine looks through every topic in the Help and returns a list of Help 
topics that are ranked by the number of occurrences of the terms in each topic.  
 
Favorites: Favorites lets you save Help topics or save strings that you wanted to access at a later time. 
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IMPORTANT INFORMATION: 
 
No offer or solicitation to buy or sell securities, securities derivative, futures products or off-exchange foreign currency (forex) 
transactions of any kind, or any type of trading or investment advice, recommendation or strategy, is made, given or in any manner 
endorsed by any TradeStation affiliate and the information made available on this Website is not an offer or solicitation of any kind in 
any jurisdiction where any TradeStation affiliate is not authorized to do business, including but not limited to Japan. 
 
Past performance, whether actual or indicated by historical tests of strategies, is no guarantee of future performance or success. 
There is a possibility that you may sustain a loss equal to or greater than your entire investment regardless of which asset class you 
trade (equities, options futures or forex); therefore, you should not invest or risk money that you cannot afford to lose. Options 
trading is not suitable for all investors. Your account application to trade options will be considered and approved or disapproved 
based on all relevant factors, including your trading experience. Please click here to view the document titled Characteristics and 
Risks of Standardized Options. Before trading any asset class, customers must read the relevant risk disclosure statements on our 
Other Information page. System access and trade placement and execution may be delayed or fail due to market volatility and 
volume, quote delays, system and software errors, Internet traffic, outages and other factors. 
 
TradeStation Group, Inc. Affiliates: All proprietary technology in TradeStation is owned by TradeStation Technologies, Inc. Equities, 
equities options, and commodity futures products and services are offered by TradeStation Securities, Inc. (Member NYSE, FINRA, 
NFA and SIPC). TradeStation Securities, Inc.’s SIPC coverage is available only for equities and equities options accounts. Forex 
products and services are offered by TradeStation Forex, a division of IBFX, Inc. (Member NFA). 
 
Copyright © 2001-2013 TradeStation Group, Inc. 
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